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C H A P T  E R 1 
 
 

 

Introducing Percussion CM System 
 

 
The Percussion CM System manages content through the automation of content creation, maintenance, 

and delivery, enhanced with features such as content reuse, delivery to multiple sites, intelligent 

relationships between content, and simple content assembly for business users. 
 

One of Percussion CM System's key features is content reuse, which it achieves by separating content and 

formatting, enabling users to create a variety of outputs using the same data. Business users can assemble 

the same Content Items multiple times using different formats and include the Content Items in the output 

formats of other content. This enables CM System to output pages to contain many Content Items 

assembled together. 
 

Another key feature of CM System is its ability to publish content to multiple sites. CM System allows 

any number of applications to be used to present published content to consumers since the content 

delivery mechanism (a portal, Web server, or other application) is not connected to CM System. This 

offers you flexibility in choosing delivery applications and simplifies the process of delivering content to 

multiple media. 
 

This document will help implementers get started with CM System by installing it with its FastForward 

sample components and Content Items, starting the Percussion CM Server, and publishing sample content. 

For more details about content creation, reuse, and delivery, and conceptual information about content 

assembly and intelligent relationships, see the CM System Concepts Guide. 
 

Note: "Percussion CM System" now replaces the name "CM System". Updated topics in this document 

refer to "Percussion CM System" or "CM System", while unchanged topics refer to "CM System". In this 

document, the names are interchangeable and refer to the same CMS system that Percussion Software 

provides to you. 
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About FastForward 
 

FastForward is a reference implementation available with Percussion CM System. FastForward includes a 

set of pre-built components and applications that allow a company to quickly bring their Web site under 

management. These pre-built components include definitions for the types of content and outputs most 

commonly implemented by customers and elements for setting up typical publishing and authentication 

scenarios. This document includes instructions for installing and reviewing these components. 
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Implementing FastForward 
 

Install, configure, and implement FastForward in a development environment and then test your features in 

a test environment. After development and testing is complete, migrate your Percussion CM System 

components to the production environment where your end users perform their work. This process ensures 

that end users only have access to completed, tested components and features. 
 

Before reading this document, read the CM System Concepts Guide for a basic understanding of the 

concepts and operation of CM System. Then use this to guide you through the process of installing CM 

System with FastForward and testing that the installation was successful and that it is publishing content 

as expected. This document also includes a "guided tour" of CM System's functionality. 
 

After reading this document, use the following documents to guide you through the process of designing 

and implementing your CM System. 
 

 Modeling and Design of a CM System Content Management System 

This document outlines the process of modeling your content and designing a CMS 

implementation to meet your needs. 
 

 CM System Implementation Guide 

This document explains the common tasks of implementing a Percussion CM System by 

illustrating the implementation of selected elements of FastForward. 
 

 Setting up the CM System Production Environment 

This document explains how to set up the production environment and deploy your 

implementation from your development environment to that production environment. 
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C H A P T  E R 2 
 
 

 

Installing CM System in a 
Development Environment 

 

 
In the recommended CM System environment, implementers create new CM System elements and features 

on a development server, perform user testing on a testing server, and install tested, new functionality to a 

production server. In technical terms, this is called a multi-tiered environment, and each Server level 

represents a tier. 
 

 
 

Figure 1: A multi-tiered environment includes development, testing and production tiers. 
 

It is important to implement FastForward on a separate development tier and integrate and test completed 

development work on a testing tier. On the development tier, configure Site structures and develop CM 

System applications and elements. On the testing tier, integrate all development work and determine if it 

functions as expected. Since features in development and testing states tend to be incomplete and unstable, 

they should never be accessible on the production tier, where users are creating and publishing actual 

content. Once testing is complete, move new components to the production tier. 
 

A Web Server must be installed on each tier to test or perform publishing. Implementers should 

successfully publish the sample content on the development tier before configuration is deployed to an 

integrated testing tier and then a production tier. 
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Preparing the Development Environment for 
CM System Installation 

 
Be certain that you are following CM System's system requirements before installing it. For the latest 

system requirements, see system requirements page at (http://help.percussion.com/cmsystem/tiki- 

index.php?page=System+Requirements+and+Installation+Prerequisites&structure=Installation). 

http://help.percussion.com/cmsystem/tiki-index.php?page=System+Requirements+and+Installation+Prerequisites&structure=Installation
http://help.percussion.com/cmsystem/tiki-index.php?page=System+Requirements+and+Installation+Prerequisites&structure=Installation
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Installing CM System 
 

CM System provides Installers for Windows and Unix. You must install your database prior to 

installation. 
 

To set up your system to use the defaults: 
 

 In your repository, define a new schema or database named RXMASTER. During installation, 

you will specify RXMASTER as CM System’s backend database. 

 If you are currently using port 9992 free it. Port 9992 is the default CM System Server port. 

You must enter your license number and installation code to install CM System. They are located on 

the back of your CD jacket. 
 

For instructions on installing CM System see Installation Examples at 

http://help.percussion.com/cmsystem/tiki-index.php?page=Installation+Examples&structure=Installation). 

http://help.percussion.com/cmsystem/tiki-index.php?page=Installation+Examples&structure=Installation
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Starting the CM System Server 
 

To start the CM System Server in Windows, in your CM System root directory, double-click on the file 

RhythmyxServer.exe. A terminal window should open and list the progress of the Server initialization. 

When the terminal window displays the message “Started in...”, the CM System Server is up and 

running: 
 

 
 

Figure 2: CM System Server Console 
 

If you have problems starting the CM System Server, see Startup (on page 79) in the 

Troubleshooting section of this document. 
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C H A P T  E R 3 
 
 

 

Introduction to Content Explorer 
 

 
Content Explorer is the default home page Percussion CM System displays when any user logs in to the 

CMS. Content Explorer gives business users access to Content Item administration functions such as 

create, approve, and copy, and gives implementers and administrators access to Publishing and Workflow 

setup screens. 

Content Explorer uses a Java Applet.  The current stable java 7 update from Oracle should be installed on 

the client machine to make sure the desktop is kept up to date with security updates from oracle.  You 

may want to wait for a few days and check the forums to make sure that any new update does not cause 

issues with the product. 
 

 
 

Figure 3: Content Explorer 
 

The following sections explain how to log in to Content Explorer and summarize the functions of each of 

its tabs. 
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Logging in to Content Explorer 
 

 
 

To log into Content Explorer: 
 

1  Open one of the supported Web browsers and navigate to http://servername:port/Rhythmyx 

where servername:port describes the location of the CM System server. For example, if 

your CM System Server is named contentmanager and you are using the default port 9992, 

enter http://contentmanager:9992/Rhythmyx. 
 

CM System prompts you to log in. 

 
 

Figure 4: Login Dialog 
 

2 Enter the User name admin1 and the Password demo, and click [Login]. 
 

Content Explorer uses a Java applet. When installing the applet, your browser displays a 

security dialog. If you see this dialog, click the [Yes] button to allow the applet to install on 

your browser. 

http://servername:port/Rhythmyx
http://contentmanager:9992/Rhythmyx
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When the applet finishes loading, CM System opens Content Explorer. The Content tab 

is selected, and the interface displays all five tabs. 

 
 

Figure 5: Content Explorer 
 

The Content Explorer banner (see "The Content Explorer Banner" on page 18) at the top of the page 

remains the same regardless of which tab is selected. 
 

The tabs available to an administrator with full access are: 
 

 Content (see "Content Tab" on page 19) 

 Publishing Design (see "Publishing Design Tab" on page 26) 

 Publishing Runtime (see "Publishing Runtime Tab" on page 23) 

 Workflow (see "Workflow Tab" on page 24) 

 Admin (see "Admin Tab" on page 25) 
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The Content Explorer Banner 
 

The banner consists of the Rhythmyx logo, the Logout button, and the login information at the far right. 

Tabs for the different Content Explorer screens are also visible. The banner remains the same regardless of 

which tab is clicked. 
 

 
 

Figure 6: Rhythmyx Banner 
 

The login information consists of three or four pieces of data: 
 

 User: The name of the user logged in to the system, in this case, admin1 

 Roles: The Roles into which the logged in user has been authenticated. If you hover your 

mouse over the value of the Roles field, the system displays a popup listing all of the Roles 

into which the user has been authenticated. The value of the Roles field is also a link. You 

can click on this link to display a popup window with the user's list of Roles as well. The 

graphics below illustrate both options: 

 
 

Figure 7: List of user's Roles 
 

 
 

Figure 8: Popup with Roles 
 

 Community: The CM System Community into which the user is currently logged. The 

admin1 user is initially logged in to the Enterprise Investments Community, as illustrated in 

the screenshot above. 

 Locale - If the user has a Locale other than US English, the login information displays the 

Locale underneath the Community. 
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Content Tab 
 

In the Content Tab, business users create and modify Content Items and transition them into Workflow 

States. This tab also allows users to actively assemble Content Items as pages or portions of pages and 

preview the results. 
 

The Content tab appears and functions similarly to the Windows Explorer interface: the left pane displays 

a Navigation Tree and the right pane is a Display pane that lists the contents of the node selected in the 

Navigation Tree. 
 

 
 

Figure 9: Diagram of Content Explorer 
 

Only the tabs for pages that the user may access are visible. If the user only has access to the Content tab, 

no tabs are visible. 
 

The Navigation pane (see "The Navigation Pane" on page 20) includes four main nodes that represent 

different ways of navigating Content Items. 
 

When a user selects a node in the Navigation Tree, the Display Pane (see "The Display Pane" on page 21) 

displays it contents. 
 

The Content tab also includes a Menu Bar (see "The Menu Bar" on page 22) with drop menus that include 

the various actions available to users in the Content tab. 
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The Navigation Pane 
 

The Navigation Pane provides you with options for locating and organizing Content Items. 
 

 
 

Figure 10: The Content Explorer Navigation Pane as displayed when first accessed 
 

The Navigation Pane consists of four main Nodes: 
 

 The Sites node is used to define Site structures and to assign Content Items to those Sites. 

When you publish content, the CMS creates a directory structure on the target Web server 

identical to the structure you define under this node. Published pages are output to the 

directory parallel to the Content Explorer Site Folder to which they have been assigned. 

 The Folders node consists of Folders used strictly to organize Content Items. The folder 

structures created under this node are not used in Publishing but for personalized organization. 

 The Views node consists of a set of pre-defined queries that return lists of content. View fall 

into four categories. 

 My Content Views 
 

This category is the richest set of default Views. Views in this category list Content Items 

checked out to the logged user, Content Items assigned to the logged user, Content Items 

the user has worked on recently, and Content Items created by the user. 
 

 Community Content Views 
 

This category consists of Views that list Content Items only in the current Community of 

the user. 
 

 All Content Views 
 

This category consists of Views that can list all Content Items in the system, regardless of 

their Community or current Workflow State. 
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 Other Content Views 

 

This generic category consists of Views that do not fit in any of the other categories. 
 

 The Searches node consists of the New Search query and several pre-defined search queries. 

Searches are somewhat simpler than Views. Views can query based on system data not 

available to searches. 

For more details about any of these nodes, see the Content Explorer Help, which you can access by 

choosing Help > Content Explorer from the Menu Bar. 
 
 

The Display Pane 
 

The larger area to the right on the Content Explorer is the Display Pane. 
 

 
 

Figure 11: Content Explorer 
 

When you initially log in to Content Explorer, the default navigation selection is always the Recent View. 

Since you have not logged in before and have not worked with any Content Items to this point, this View 

has no results, as illustrated in the graphic above, which shows the text "No search results to display". 
 

Expand the Sites node, and select the Enterprise Investments Folder. Now the Display Pane lists the 

contents of this Folder. This Folder includes a number of Subfolders (such as About Enterprise 

Investments, Investment Advice, and Products and Services) and a couple of Content Items (EI Home 

Page and Enterprise Investments Internet Root). 
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The Menu Bar 
 

The Menu bar separates the banner from the Navigation and Content Panes. 
 

The Menu bar consists of three menu options and the Content Path. The Content Path lists the Navigation 

path to the object currently selected in the Navigation Pane. 
 

The following Menu options are available: 
 

 Content 

The Content Menu consists of options for managing Content. This menu includes three 

options: 
 

 New 
 

The New Menu consists of two submenus: New Item and Folder. The Folder option is 

only available if you are in either the Site or the Folder node, or a Subfolder of one of 

these nodes. The Folder option allows you to create a new Folder. The New Item option 

lists all Content Types for which the current user has access to create a new Content Item. 
 

 Search 
 

This option launches a new Search. 
 

 <selected Navigation Pane node> 
 

This name of the selected node in the Navigation pane. Submenu options available from 

this choice include the right-click options for the node. 

 View 

The View Menu includes two choices. The Refresh option refreshes Content Explorer. The 

Options choice activates the Display Options dialog, where you can modify the display 

settings for Content Explorer. 

 Help 

The Help Menu includes two options. The Content Explorer option activates the Content 

Explorer Help. The About option activates the About Content Explorer dialog. 



Chapter 3    Logging in to Content Explorer 23 
 
 
 
 
 
 

 

Publishing Runtime Tab 
 

The Publishing Runtime tab provides the capability of initiating Publishing of an Edition and of reviewing 

the results of all Publishing jobs (whether initiated manually or automatically). 
 

 
 

Figure 12: Publishing Runtime Tab 
 

For details about publishing Editions and reviewing publishing results, see the CM System Administration 

Manual. 
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Workflow Tab 
 

A Percussion CM System Workflow is a set of States that a Content Item progresses through during its 

lifetime. In general, Content Items are published after they pass through one or more approval States and 

reach a publish State. 
 

The following graphic shows how the default Workflow tab appears when FastForward is installed. Your 

Workflow tab should also display the Simple and Standard Workflows. 
 

 
 

Figure 13: Workflow Tab 
 

For more information about Workflows and the Workflow tab, see the section on Workflows (see 

"Workflow" on page 62), below, and the Workflow Online Help or the document CM System 

Implementation Guide. 
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Admin Tab 
 

The Admin tab includes links to pages used to administer and maintain the Percussion CM System, 

including: 
 

 Console 

This page is used to issue commands to the Percussion CM server. 
 

 Variant to Template Migration Tool 

This page is used on systems upgraded from CM System Version 5.7 or earlier to CM 

System 

Version 6.0 or later to migrate XSLT Variants to Velocity Templates. 
 

 Run RxFix 

This tool should only be used under the direction and guidance of a Percussion Software 

Technical Support Representative. 
 

 Run Repository Consistency Checker 

This tool should only be used under the direction and guidance of a Percussion Software 

Technical Support Representative. 
 

 Scheduled Tasks, Task Notifications, and Task Logs 

For details about maintaining Scheduled Tasks and Task Notifications, and reviewing 

Scheduled Task logs, see the CM System Administration Manual. 
 

 

 
 

Figure 14: Admin Tab 
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Publishing Design Tab 
 

The Publishing Design table includes links to pages for configuring publishing infrastructure, including: 
 

 Sites, and the Content Lists and Editions associated withe each Site 

 Contexts 

 Delivery Types 

 
 

Figure 15: Publishing Design Tab 
 

For more information about the options on this tab, see the Help for the tab, or the following 

documentation: 
 

 Sites: "Setting Up the Publishing Site and Basic Navigation" in the CM System Implementation 

Guide. 

 Content Lists, Editions, and Context: "Configuring Publishing" in the CM System 

Implementation Guide. 

 Delivery Types: "Configuring a Delivery Type" in the CM System Technical Reference 

Manual. 
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Publishing A Default Edition 
 

 
Before you have made any modifications to your CM System system, it is good practice to publish 

some content to validate that the publishing system has installed correctly. 
 

Compare your current publishing results to those you receive later, during the tutorial part of this 

document, when you add content items and a folder to the site. 
 

Now you will publish the preconfigured Enterprise Investments Full Edition, which includes the entire 

Enterprise Investments website. 
 

To publish the Enterprise Investments Full Edition: 
 

1 In Content Explorer, click on the Publishing Runtime tab. 
 

2  Expand the Sites node; under the Sites node, expand the Enterprise Investments node. Expand 

the Editions node. 
 

3 Click on EI_Full. 
 

The edit and view pane displays the Runtime Edition page. 
 

4 In the menu, choose Start. 
 

The edit and view pane displays Edition progress data, including the following: 
 

 Progress bar 
 

 Start Time 
 

 Elapsed time since the Edition was initiated. 
 

 Current State of the Edition 
 

 Number of Content Items Queued 
 

 Number of Content Items Delivered 
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 Number of Content Items for which publishing Failed 

 
 

Figure 16: Edition progress data 
 

When the publishing job has completed, the results will be displayed in the Logs. The result 

should resemble the following screenshot: 

 
 

Figure 17: Log listing for completed Edition 
 

Click the log's Job ID to see the results of the publishing job: 

 
 

Figure 18: Log for the EI_Full Edition publishing run 
 

Click on an individual Content id to see its results in the job. This tool is particularly useful to 

determine why a Content Item failed. (the following is an example of the error message for an 

item that failed to publish. It is unlikely that your publication will have any failures.) 
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In this example, the Template that was being published did not include any Velocity code. 
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C H A P T  E R 4 
 
 

 

A Brief Tutorial 
 

 
The next section of this document will walk you through the basics of creating content items, assembling 

them into pages, moving them through approval processes, and publishing them to your website. The 

purpose of this tutorial is to help you implement your Percussion CM system by giving you an 

understanding of how your system's business users will use your implementation. 
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Creating Content Items 
 

 
Content Items are the basic units of content in Percussion CM System. A Content Item is usually a portion 

of a page, such as a block of text, an image, or a banner, header, or footer. In some cases, such as home 

pages, a Content Item may be a complete page, but more commonly, a Content Item is a portion of a page. 
 

By defining content in such a granular manner, CM System provides users greater control over the 

content. You can use the same Content Item in multiple ways on different pages. Further, if editing is 

necessary, you only need to change the Content Item that needs to be modified, and do not disturb other 

parts of the page. 
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Creating a Generic Content Item 
 

Let us begin by creating a simple Generic Content Item. 
 

You should always create new Content Items in a Folder so you can find them easily. Percussion CM 

System does not require you to be in a Folder when you create a Content Item, but if you do not create the 

Content Item in a Folder, you will need to search for it or use a View to find it. We will create our 

Content Item in a Site Folder. 
 

In the Navigation pane, expand the Sites node, and select the Enterprise Investments Site Folder. Notice 

that when you select this Folder, the contents of the Folder are displayed in the Content Pane. Double- 

click on the "About Enterprise Investments" Folder. We will create our new Content Item in this Folder 

for now. 
 

Percussion Software provides the content for this new Content Item, and several others we recommend 

that you create in the course of this walk-through. The content is provided in a set of .txt files in the 
<Rhythmyxroot>/Samples/ffsamples directory. If your Percussion CM server is on a remote machine, 

you may want to copy the contents of this directory to your local machine. We are going to use the 

tuition.txt file to provide the content for our example Content Item. Open this text file in a simple text 

editor such as Notepad. 
 

To create your new Generic Content Item: 
 

1 In the Menu bar, choose Content > New > New Item > Generic. 
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The CMS pops up a blank Generic Content Editor: 

 
 

Figure 19: Generic Content Editor 
 

2  Change to the Tuition.txt file, and copy the first line. Change back to Content Editor and 

paste this text in the System Title field. Paste it again into the Title field. 
 

3 Note that the Start Date defaults to the current date. Do not change the value in this field. 
 

4  Change to the Tuition.txt file and copy the second line. Change back to the Content Editor 

and paste this text into the Description field. 
 

5 Click the design tab at the bottom of the  Callout field to enable it. Change to the 

Tuition.txt file and copy the third line. 

Change back to the Content Editor and paste this text into the Callout field. 
 

6  Click the design tab at the bottom of the Body field to enable it. Change to the Tuition.txt file 

and copy the text from the beginning of the third line to the end of the file.  Change back to 

the Content Editor and paste this text into the Body field. 
 

7  Click the [Insert] button. You will be briefly redirected to a page asking you to wait a 
moment while your Content Item is uploaded to the repository, then redirected again the 

Content Editor. 
 

You have just added a new Content Item to the CM System's Repository. 
 

8  Click the [Close] button to close the Content Editor. Note that the new Content Item, 
"Tuition Tax Credits and Deductions Offer Free Money from the IRS" has been added to the 

Enterprise Investments Folder. 
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9  Right-click on "Tuition Tax Credits and Deductions Offer Free Money from the IRS" in 

Content Explorer. A menu of options opens. Move your cursor to Enterprise Active 

Assembly. This option includes a set of links you can use to preview different formatted 

outputs of the Content Item. For example, if you click the P - EI Generic link, CM System 

displays a window similar to this: 

 
 

Figure 20: P - EI Generic Format 
 

This page illustrates how the Content Item would look as a published Web page. 

If you click the S - Title Callout Link, you see a window similar to this: 
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Figure 21: S - Title Callout Link Format 
 

Both links launch the item in Active Assembly. Active Assembly consists of a two-panel interface that lets 

you edit content items directly on the page. The left panel is referred to as Outline view, and the right 

panel is referred to as Page view. Later in this document, we will complete various tasks in the Active 

Assembly interface. For complete information on Active Assembly, see the Active Assembly Interface 

Help. 
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Creating a Generic Word Content Item 
 

Percussion CM System has been designed with enough flexibility that you can connect to third-party tools 

as Content Editors. One of the most common tools used for creating content is Microsoft Word word 

processor. The Generic Word Content Type provides the option of entering and maintaining Content Items 

using Microsoft Word. We will enter Content from the sample Content File SavingForCollege.txt. You 

should still be in the Enterprise Investments/About Enterprise Investments Folder to create this Content 

Item 
 

Note that before you can launch Word from CM System, you must update your security options. In 

Internet Explorer choose Tools > Internet Options and click the Security tab: 
 

 Make your Percussion CM server a trusted site (Click the [Sites....] button then the 

[Advanced] button. In the Add this web site to the zone... dialog, enter http://localhost (or the 

name or IP address of the remote machine where your Percussion CM server resides) and 

click [Add]. Click [OK] twice to return to the Security tab. 

 Click the [Custom level...] button and on the Security Settings dialog, find the Download 

signed ActiveX controls entry. Select either Enable or Prompt for this option. 

 Click [OK] twice to close the Tools window. 

 Refresh the Content Explorer screen. 

To create a Generic Word Content Item: 
 

1 In the Menu bar, choose Content > New > New Item > Generic Word. 
 

The Generic Word Content Editor uses an ActiveX control to launch Microsoft Word. 

Percussion Software has signed that this ActiveX control is safe, so click the [Yes] button if 

asked whether you want to run the control. After you click [Yes], the CMS pops up a blank 

Generic Word Content Editor. 
 

2  Change to the SavingForCollege.txt file, and copy the first line. Return to the Content Editor 

and paste the first line into the System Title field. 
 

3  Click the Callout field to activate it. Change to the SavingForCollege.txt file and copy the 

second line. Return to the Content Editor and paste this text into the Callout field. 
 

4 Click the Launch Word link. 
 

CM System launches Microsoft Word. Content editing using Microsoft Word requires the use 

of Word Styles to mimic fields in CM System. These styles are stored in the GenericWord 

template. The template includes Word macros that convert the styles into CM System fields 

during the upload process. You can implement your own Word-based Content Editors. For 

details see the document Implementing Word in CM System. 
 

5  Change to the SavingForCollege.txt file, and copy the first line again. Switch to the instance 
of Word and paste it.  Notice that the Style for this paragraph is PageDisplayTitle. The 

content of this paragraph will be entered into that field in the Repository. 
 

6 Hit the <Enter> key on your keyboard. The new paragraph has the Style PageAuthor. In the 

Style drop list in Word, choose the style PageBody 

http://localhost/


38 Getting Started with Percussion CM System 
 
 
 

 

7  Change to the SavingForCollege.txt file and copy from the beginning of the second line 

through the end. Paste this text into the Word document. 
 

8 In the Word button bar, click the Save to CMS button  . 
 

9 Word displays a File Name dialog. Enter the text SavingForCollege. 
 

10 Click [OK]. 
 

11 Word displays a confirmation dialog: 

 
 

Figure 22: Confirmation dialog displayed when you have successfully uploaded your Content Item into 

Word 
 

12 Click the [Yes] button. You will return to the CMS with the Saving For College Content Item 

displayed in the Display Pane. The Content Item is located as the result of a background 

search; if you do not see it, click the Search Results node in the left pane. 
 

13 Right-click on the Saving For College Content Item and choose Edit from the popup menu. 
 

CM System displays the Saving For College Content Editor. 
 

14 At the bottom of the Content Editor, you will find links for viewing this Content Item in 
Active Assembly in different formats. Click on these links to view the formats available for 

the Content Item. 
 

15 When you have finished, click the [Close] button. 
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Creating an Image Content Item 
 

Image Content Items are used to manage graphics used as content on Web pages. 
 

Note that some graphics are used within the page layout itself. Examples include company logos and 

spacers used to define page layout. These graphics, which are referred to as static images, are not 

managed by the CMS but reside on the Web server so they can be included in the Published pages. 
 

Content images, however, are managed as Content Items of the Image Content Type. Once an Image 

Content Item exists in the system, you can use it in any Slot that allows Image Content Types. 
 

An example graphic (moneyroll.jpg) is included in the FastForward sample directory. If you are 

connecting to your Percussion CM server from a remote machine, you might want to copy this file to your 

local machine. 
 

To create the Image Content Item: 
 

1 In the Navigation Pane, expand the Enterprise Investments Site Folder, then expand the 

Images Site Folder. Double-click on the People Folder. 
 

2 In the Menu bar, choose Content > New > New Item > Image. 
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CM System displays the Image Content Editor. 

 
 

Figure 23: Image Content Editor 
 

3 In the System Title and Title fields, enter Money Roll. 
 

4 Click the [Browse] button next to the Image field. 
 

CM System displays a browse dialog. 
 

5  Browse to the <Rhythmyxroot>/Samples/ffsamples directory, select the file moneyroll.jpg.and 

click the [Open] button. 
 

CM System adds the path and filename you specified (for example, 

C:\Rhythmyx\Samples\ffsamples\moneyroll.jpg). 



Chapter 4    Creating Content Items 41 
 
 
 
 

 
6 On the Content Editor window, click the [Insert] button. 

 

7  CM System uploads the file and refreshes the Content Editor window. Once the window has 

refreshed, the read-only fields Image File Name, Image Mime Type, Height, and Width include 

data. 
 

8 Click the [Close] button to close the Content Editor 
 

9 The new Money Roll Image Content Item has been added to the Folder. 

Two additional sample image files are included in the FastForward Samples directory, 

Girllookingatcamera.jpg and taxandglasses.jpg. Add these as Image Content Items to the same Folder. 
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Working with Site Folders 
 

 
As discussed earlier, Folders are the fundamental mechanism the system provides for users to organize 

and navigate content. Folders in Percussion CM System are similar to Folders in Microsoft Windows. 

The major difference is that the folders in Windows are physical directories on the file system. Files in a 

folder in Windows are physically located in that Folder. 
 

In CM System, Folders define virtual locations you can use to organize and navigate content. The Content 

always exists in the Repository, not in the Folders. The Folders merely contain pointers to the physical 

Content Items stored in the Repository. 
 

The Navigation Pane includes two roots that contain Folders. The Sites Root is used to define Site 

structures. When you publish a Site, CM System creates a directory structure on the target server parallel 

to the Site Folder structure you have defined under this node. Note that you can create a several Sites 

under this node, each of which can be published separately. The Folders Root contains Folders that are 

used more generically for organization. The Folders under this root are not published. 
 

Otherwise, Folders function identically regardless of the root to which they belong. 



Chapter 4    Working with Site Folders 43 
 
 
 
 
 
 

 

Creating the Education Folder 
 

We want to create a new subsection (Education) for the Investment Advice section of our Web site.  This 

section will require a new directory to store the Web pages for the new section. We create the new 

section, and the new directory, by creating a new Folder. 
 

To create the new Education Folder: 
 

1 In the Navigation Pane, expand the Enterprise Investments node, and select the Investment 

Advice node. 
 

2 In the Menu bar, choose Content > New > Folder. 
 

The CMS displays the Create Folder dialog. 

 
 

Figure 24: Create Folder dialog 
 

3  In the Folder Name field, enter Education. You can enter a free-form Description if you wish, 

but that is not necessary. Leave the defaults in all other fields. 
 

4 Click the [OK] button. 
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The CMS adds the new Folder under Investment Advice. 

 
 

Figure 25: Education folder 
 

Double-click on the Education Folder. The display pane shows the contents of the Folder. Notice that 

this Folder already has a Content Item, Education, of the Navon Content Type. This Content Item is 

created automatically by the Managed Navigation functionality. It is used to generate navigation for the 

Web site automatically when it is published. For more about Managed Navigation see Maintaining 

Managed Navigation for the Education Folder (on page 69). 
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Moving Content into the Education Folder 
 

Since Web pages are published to the directory corresponding to the Site Folder in which they are located, 

we want to move the Content Items we previously created into the new Folder. 
 

Let us move the Tuition Content Item first. To move the Tuition Content Item: 
 

1 Select the EnterpriseInvestments Folder. 
 

2  In the Navigation Pane, select the About Enterprise Investments Folder so you can see its 

contents in the Content Pane. 
 

3  In the Content Pane select the Tuition Content Item, and drag it to the 
InvestmentAdvice/Education Folder (as you drag the Content Item, you will notice a small 

dotted square below the mouse pointer; this square indicates that you are dragging the Content 

Item. 
 

4 Place the mouse pointer over the Education Folder and release. 
 

A dialog pops up with the following options: 
 

 Move 
 

 As Link 
 

 As New Copy 

 

5 Select the Move option. 
 

The Tuition Content Item is removed from the Content Pane. 



46 Getting Started with Percussion CM System 
 
 
 

 

6 Select the Education Folder. The Tuition Content Item has been moved to the new location. 

 
 

Figure 26: Education Folder with moved item 
 

7 Use the same procedure to move the Saving for College Generic Word Content Item into the 

Education folder. 
 

8 Now go into the EnterpriseInvestments/Images/People folder and move the Money Roll, Girl 

Looking at Camera, and Tax and Glasses Content Items into the Education Folder. 
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Adding Additional Content to the Education 
Folder 

 
Two additional sample txt files, TenThingstoknow.txt and Section529Plans.txt are included in the 

Samples directory. Use these to create two more Generic Content Items, "Important Things to Know 

About Saving for College" and "Section 529" Plans in the Education Folder. 
 

When you have created these Content Items, the Education Folder should resemble the following 

screenshot: 
 

 
 

Figure 27: Education Folder 
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Active Assembly 
 

 
Now that we have some Content Items, we want to create links between them. In Percussion CM System, 

the process of creating these links is called Active Assembly. When you use Active Assembly to link one 

Content Item to another, you are creating an Active Assembly Relationship between the two Content Items. 
 

Active Assembly Relationships are one category of associations between Content Items. CM System 

provides the ability to create a variety of associations between Content Items. Collectively, these 

associations are known as Relationships. For more details about Relationships in general, see 

Implementing the Relationship Engine. 
 

An Active Assembly Relationship defines how one Content Item (referred to as the Dependent) will be 

included in another Content Item (which is called the Owner because it owns the Relationship) when the 

content is published. Active Assembly is used for one of two reasons: 
 

 to embed one Content Item into another (typically used for graphics, but occasionally also 

used to embed text from one Content Item into another); 

 to create a link from one Content Item to another (such as a hypertext link between two pages, 

or call to a binary file to be displayed to the user). 

We will perform both types of Active Assembly, adding links between the pages we created and adding 

images to the pages. 
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Adding Links to Other Generic Pages in the 
Sidebar Slot 

 
On the P - EI Generic Template, the Sidebar Slot is used to create links to other Content Items that contain 

content related to the topic on the current page. Let's create a link from the Tuition Content Item to the 

other new Education Content Items we created. 
 

To create related content in the Sidebar Slot: 
 

1 In the Navigation Pane, select the Education Folder. 
 

2  Right-click on the Tuition Content Item and choose Enterprise Active Assembly > P -EI 

Generic from the popup menu. 
 

CM System displays the P - EI Generic format of the Tuition Content Item in the Active 

Assembly Interface. 

 
 

Figure 28: Tuition item in P - EI Generic format 
 

In Active Assembly, you can modify the Snippets in the Slots on this Template. 
 

3 In Outline View, find Sidebar slot, and right-click the  icon, and choose Insert Snippet 

from the drop menu. 
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CM System displays the Content Browser. 

 
 

 
 

4 Click the Search tab. 

 

Figure 29: Content Browser 
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Two versions of this tab are available. If you are using the full-text search engine, you will 

see: 

 
 

Figure 30: Content Browser, Search Tab 
 

If your system is using the database search engine, you will see: 



52 Getting Started with Percussion CM System 
 
 
 
 

 
 

Figure 31: Content Browser, Search tab 
 

5  If you are using the Full-text Search engine, enter college into the Search for field. If you are 

using the database search engine, enter college into the Title field. Click the [Search] button. 
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6 CM System returns the Search results: 

 
 

Figure 32: Search results 
 

7 We want to insert the Section 529 College Savings Plans content item, so we click it. 
 

A page that lets us choose the Template or format for the content item opens. It lists five 

Templates with which we can format the item: 
 

 S - Callout 
 

 S - Image Link 
 

 S - Title Callout and More Link 
 

 S - Title Callout Link 
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 S - Title Link 

 
 

Figure 33: Template selection page 
 

8  Click each option under Select a template to see in Template Preview how it formats the 

content item. 
 

We want to create a link to the specified page using the Title and Callout of the target Content 

Item, so we will use the S - Title Callout Link Template. 
 

9 Select S - Title Callout Link and click [Select]. 
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The Content Browser returns to the page of search results so you can add another item to the 

Slot. If you move the Content Browser over so you can see the Sidebar Slot where it appears 

in Page view, you will see that the Section 529 College Savings Plans content item has been 

added to the Slot. 

 
 

Figure 34: Snippet added to Slot 
 

10 Repeat Steps 7 - 10, adding the Important things to know about saving for college content 

item in the format of the S - Title Callout Link template. 
 

11 When you return to the Search results, click [Back] to return to the search screen. Since you 

do not want to enter another search, click [Close]. 
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The Content Browser closes and the page for the Tuition Content Item now resembles: 

 
 

Figure 35: Sidebar Slot with two Snippets added 
 

When you begin with an empty Slot, each new Snippet that you add to the Slot with the 

Content Browser is inserted at the bottom of the Slot, so the Important things to know about 

saving for college Snippet appears below the Section 529 College Savings Plans. 
 

Each of the titles in the Snippets that you have added is a link to the Web page for that item. 

To see this press ALT and click on one of the Snippet titles. 
 

The CMS opens the page that the title links to. 
 

12 When you have finished, close the Active Assembly window for the Tuition Content Item. 
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Adding an Image to a Generic Page 
 

Now let us add an image to one of our Education Content Items. In this case, let us add an image to the 

rich-text Body field of the Content Item. 
 

1 In the Navigation Pane, select the Education Folder. 
 

2  In the Content Pane, right-click on the Tuition Content Item and choose Edit from the popup 

menu. 
 

The CMS displays the Tuition Content Editor. 
 

3 Scroll down to the Body field, and place the cursor before the first character in the field. 
 

4 Click the Insert CMS Image button . 
 

CM System displays the Content Browser. 
 

5 Click the Search tab. 
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Two versions of this tab are available. If you are using the full-text search engine, you will 

see: 

 
 

Figure 36: Content Browser, Search Tab 
 

If your system is using the database search engine, you will see: 
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Figure 37: Content Browser, Search tab 
 

6  If you are using the Full-text Search engine, enter glasses in the Search for field. If you are 

using the database search engine, enter glasses in the Title field. Click the [Search] button. 
 

CM System returns the search results. 
 

7 We want to insert the Tax and Glasses content item, so we click it. 
 

A page that lets us choose the Template or format for the content item opens. In this case, 

there is only one Template available for the item: 
 

 B - Image 
 

8 Select B - Image and click [Select]. 
 

The image is added to the Body text. The Content Browser closes. 
 

9 Now let us format the graphic so it merges more smoothly with the text. Click the graphic. 
 

A black border appears around it. 
 

10 Right-click on the graphic and choose Image Properties from the popup menu. 
 

CM System displays the Image Properties window. 
 

11 In the Alignment drop list, choose Left. 
 

12 Click the [OK] button. 
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13 The text will now flow around the graphic, similar to the following screenshot: 

 
 

Figure 38: Graphic with text flowing around it 
 

14 Click the [Update] button to upload the changes to the Repository. 
 

When the changes have been uploaded, the Content Editor will refresh. 
 

15 Click [Close]. 

Now, add the Money Roll Image to the 529 Content Item and add the Girl Looking at Camera Image to 

the Important Things... Content Item. You may want to try alternative formatting for these images (for 

example, aligning right instead of left). 
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Previewing the Content Item 
 

Now that we have added Snippets to the Slots in our Content Items, let us preview them to see how they 

will look when published. 
 

To preview the Tuition Content Item: 
 

1 In the Navigation Pane of Content Explorer, open the Education folder. 
 

2 Right-click on the Tuition Content Item and on the popup menu choose Enterprise Preview > 

P - EI Generic. 
 

3 A preview of the Tuition Content Item opens. 

 
 

Figure 39: Preview of Tuition content item 
 

Note that the page includes the graphic and the content items in the Sidebar Slot that we added. 
 

Click on the Important Things or Section 529 content item. A preview of the selected page opens. These 

previews give you an idea of how the pages will look when published. Note, however, that when content 
is published, the Snippets in the Slots will only be included if they are Public. The following section, 

which describes Workflow, explains how to make these new content items Public. 
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Workflow 
 

 
A Workflow is a business process that defines the life cycle of a Content Item. In Percussion CM System, 

every Content Item must exist within a Workflow. The Workflow defines: 
 

 the steps or stages in the processing of the Content Item; 

 which users can access the Content Item at a particular point in its life cycle; and 

 what different users can do to the Content Item at each point. 

CM System defines a Workflow as a series of stages, or States, which define the life of the Content Item. 

In each State, users in specific Roles have access to the Content Item. Users in some Roles can modify 

the Content Item, while users in other Roles can only see and read the Content Item. Users with the 

correct access can also Transition Content Items, moving them between States in a Workflow. 
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Check In and Check Out 
 

The check in and check out functionality allows multiple users to have access to all Content Items, but 

prevents more than one user at a time from modifying a Content Item. When a user checks out a Content 

Item, only that user can edit the Item; it is unavailable to all other users. 
 

Check in and check out are special types of Transitions. Check in and check out do not move a Content 

Item from one State to another, as do normal Transitions. Instead, check in sets a lock flag that indicates a 

user has the Content Item checked out. Check in removes this flag. 
 

In many cases, CM System checks Content Items in and out automatically. In a few cases (notably when 

initially creating a Content Item or after modifying the Content Item), you must check the Item in 

manually. 
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About Roles 
 

A Role is a collection of users with the same access in Percussion CM System. In Workflows, Roles 

determine which users can access content in each State and which Transitions they can apply. 
 

Organizing users into Roles helps administrators manage users that have the same permissions. Instead of 

managing the permissions for each user, they define a Role its permissions, then assign users to it.  Users 

inherit their access rights from the Roles to which they are currently assigned. 
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About the Standard Workflow 
 

The Generic Page Content Type uses the Standard Workflow, one of two basic Workflows included with 

FastForward. The Standard Workflow is a common structure that requires one approval before going to 

Public. 
 

 
 

Figure 40: Preview of Standard Workflow 
 

Note that the Standard Workflow includes a Pending State between the Review and Public States. This 

State is included to support internationalized systems. In some cases, internationalized systems require 

that Translations of Content Items be Published at the same time as the original. The Pending State 

provides a holding area" for original Content Items while waiting for the Translations to be completed. 
 

The Public State is the State in which the Content Item is eligible to be Published. When a Content Item 

reaches this State, it will be published the next time the Publisher runs. 
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The Quick Edit State is provided to allow quick touch-ups to Content Items without forcing them through 

the complete Workflow again. For example, if you find a misspelling or minor grammatical error on the 

Content Item, there is usually no need for it to go back through the complete approval process. Instead, 

you can move it to Quick Edit, make your change, and return the Content Item to Public immediately. Note 

that your changes will not be reflected in the published output until the Content Item is re-published. 
 

Finally, the Archive State provides a terminal State for Content Items after they have expired. The 

Content Items continue to exist in the system, and if necessary can be revived. (In the Standard 

Workflow, revised Content Items are returned to the Draft State and must go through the complete 

Workflow before they can return to Public.) 
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Transitioning Content Items to a New State 
 

Now that we have finished creating our Content Items and adding related content, we want to make them 

Public so we can publish them. We will need to perform Transitions on the Content Items. 

To Transition the Tuition Content Item: 

1 In the Navigation Pane, go to the Education Folder. 
 

2 Right-click on the Tuition Content Item and on the popup menu, choose Workflow > Submit. 
 

3 A Workflow Comment window opens. You can enter a free-form comment in this window. 

 
 

Figure 41: Workflow Comments Popup 
 

4 Click the [OK] button to continue making the Transition. 
 

5 A Message Box informs you that the system is processing the Tuition Content Item. 
 

6  When the message box disappears, the Transition is complete, and the Content Item is now in 

the Review State. 

Repeat the process above for the remaining new Content Items (Important Things to Know, Section 529 

Plans, Money Roll, Tax and Glasses, Girl Looking at Camera, Saving for College). 
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Moving Content Items to Public 
 

We are going to assume for our purposes that these Content Items are all ready to go Public. Rather than 

Transition them individually, we can Transition them all at once. 

To Transition multiple Content Items: 

1  Select the Content Items you want to Transition. In this case, we want to Transition all the 

Generic Page Content Items, the Generic Word Content Item, and the Image Content Items. 

The Content Explorer applet supports multi-select. You can hold down the <CTRL> key 

while selecting Content Items, or if multiple Content Items are adjacent, select the first 

Content Item, then hold down the <Shift> key while selecting the last Content Item you want 

to select.  All Content Items in between will be selected as well. 
 

2 Right-click and from the popup menu, choose Workflow > Approve. 
 

When you multi-select, Content Explorer displays only the Transitions that all selected 

Content Items have in common. In this case, the Content Items should have the following 

Transitions in common: 
 

 Check-out 
 

 Approve 
 

 Rework 
 

If the selected Content Items have no Transitions in common, when you select Workflow 

from the popup menu, the submenu option will be No Entries. 
 

3  The Workflow Comment window opens. If you enter a comment in this window, it will be 
added to the record for all selected Content Items. You cannot enter different comments for 

different Content Items in the selection. If you want to enter different comments for different 

Content Items, you must Transition them individually. 
 

4 Click the [OK] button. 
 

A message window shows the Content Items it is Transitioning. When the message window 

disappears, all selected Content Items have been Transitioned. 

The selected Content Items are now in the Pending State. Ordinarily, when using the Standard Workflow, 

The Aging functionality moves the Content Items to Public automatically. In the Standard Workflow, an 

Aging Transition has been added from the Pending State to the Public State. This Transition will 

automatically move the Content Items to Public based on the System Field Start Date. Recall that we 

preserved the default Start Date, which is the current date, when we created our Content Items. When the 

aging process (known as the Aging Agent) runs, it will find our Content Items, and note that their Start 

Date is the current date (or the past date when you created them). Thus, it will move the Content Items to 

Public automatically.  The Aging Agent runs every ten minutes, so you may have to wait a few minutes 

for your Content Items to Transition automatically. 
 

If you don't want to wait, another Transition, Force to Public, is also available from the Pending State. 

Note: The Force to Public State is only available to users in the Admin role. 



Chapter 4    Maintaining Managed Navigation for the Education Folder 69 
 
 

 
 
 
 
 
 

Maintaining Managed Navigation 
for the Education Folder 

 

 
Recall that when we created the Education Folder, Percussion CM System automatically created a Navon 

Content Item of the same name in the Folder. Navons are Content Items, and act like other Content Items in 

the system. They include Slots and have related Content Items assigned to them. Navons also exist in a 

Workflow and can be Transitioned. During assembly, however, Navons are treated somewhat differently. 

CM System uses them to create a background XML document that it uses to apply navigation to published 

pages. 
 

To ensure that our Education Folder and its content are published correctly, we will need to assign a 

Content Item to the Landing Page Slot of the Education Navon, and we will have to make the Navon 

Public. 
 

Note that although the user admin1 can see the Education Navon in the EI Community, this Content Item 

actually exists in the Enterprise Investments Admin Community. 
 

You must change the Community admin1 is logged in to from Enterprise Investments to Enterprise 

Investments Admin. 
 

To change the Community: 
 

1 In the banner at the top of the page, next to the Community label, click Enterprise 

Investments. 
 

The Select a Community dialog opens. 
 

2 Choose Enterprise Investments Admin in the drop list and click [Go]. 
 

Content Explorer opens again. 
 

3 Confirm that the Community next to the Community label is Enterprise Investments Admin. 
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Creating a Landing Page for the Education 
Folder 

 
A landing page is the page you are directed to when you click on a link in the Navigation part of a CM 

System page. 
 

You must specify the landing page. 
 

To add a Landing Page to the Education Navon: 
 

1 In the Navigation Pane, go to the Education Folder. 
 

Navons generally act like normal Content Items in the system, so they include Slots. 

However, during assembly, Navons are used to create a background XML document that is 

used to add navigation to published pages. They are never assembled into Snippets or Pages. 

Therefore, you cannot use the Active Assembly Preview to maintain the Slots on a Navon. 

You must use the Active Assembly Table Editor to add related content to the Slots on a 

Navon. 
 

2 Right-click on the Education Content Item and on the popup menu, choose Active Assembly 

Table Editor. 
 

3 CM System displays the Active Assembly Table Editor. 

 
 

Figure 42: Navon Table Editor 
 

4 Click the nav_landing_page link. 
 

5 CM System displays the Content Browser. 
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6 Click on the Search tab. 

 

7 Search on the term "tuition". 
 

8 Click the Tuition content item. 
 

The Select a Template window opens. The only option is the S - Title Link Snippet. 
 

9 Click [Select]. 
 

10 The Tuition Content Item is added to the Nav Landing Page Slot on the Table Editor. 

 
 

 
 

11 Close the table editor. 

 

Figure 43: Landing Page Added 

To see how the landing page works, Preview the Enterprise Investments Home Page, which is located in 

the Enterprise Investments top folder. 
 

To see the landing page: 
 

1 In the Navigation pane, click the Enterprise Investments folder. 
 

2 Right-click EI Home Page and choose Enterprise Preview > P - EI Home. 
 

The home page opens. 
 

3 In the left navigation panel, under Investment Advice, click the Education link. 
 

The Tuition Tax Credits page opens. It includes links to the Education Content Items we 

added. 
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Making the Education Navon Content Item 
Public 

 
Before our new Education section can be published correctly, we need to make the Education Navon 

Public. 
 

Use the same procedure that you used to Transition the other Content Items. Notice that when you choose 

Workflow from the popup menu, the submenu includes the option Direct to Public. We will not be 

making any additional changes to the Education Navon, so use this Transition. 
 

When you are finished, all of the Content Items in the Education Folder, including the Education Navon, 

will be Public. Now you are ready to publish this Site with the new Section. 
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Publishing the Web Site with the 
Education Section 

 

 
Now that we have added our new section, we are ready to publish the Web Site to include it. The 

FastForward publishing configuration is set up to publish the content to the JBoss application server 

installed with the system. 
 

Once again, you will publish the Enterprise Investments Full Edition. Notice the new components that are 

published since you have added a folder, content items, and additional navigation to your system. 
 

To publish the Site: 
 

1 In Content Explorer, click on the Publishing Runtime tab. 
 

2  Expand the Sites node; under the Sites node, expand the Enterprise Investments node. Expand 

the Editions node. 
 

3 Click on EI_Full. 
 

The edit and view pane displays the Runtime Edition page. 
 

4 In the menu, choose Start. 
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When the publishing job has completed, the results will be displayed in the Logs. The result should 

resemble the following screenshot: 
 

 
 

Figure 44: Publish Log 
 

Click the log's Job ID to see the results of the publishing job, and click on an individual Content id to see 

its results. 
 

If the new content was published successfully, when you go the Publishing target location (by default: 

<Rhythmyx root> \AppServer\server\rx\deploy\EI_Home.war\) you will see the new 

Education subdirectory in the Investment Advice directory. 
 

 
 

Figure 45: Published Education Folder 
 

If you do not see this directory, none of the Content Items in the Site Folder were published. If you do not 

see a specific Content Item, it was not published. Review the log for these Content Items to determine 
why they were not published. The most common reason for Content Items not to be published is that they 

are not in a Public State. Go back to the Content tab of Content Explorer and Transition all of the Content 

Items in the Education Folder to Public. 
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Another reason that the Education directory might not be created is that it does not contain any Content 

Items. Go back to the Content tab of Content Explorer and move the Education Content Items to the 

Education Folder. 
 

If you open the Education directory, you will see four new HTML pages. The names of these files will be 

itemNNN.html. The value of NNN will be the Content IDs of the Generic Page and Generic Word 

Content Items you created during this walk-through. You will also see three new JPG pages. These are 

the image Content Items that you created. The values should resemble those in the graphic below: 
 

 
 

Figure 46: Contents of Education Folder 
 

If any of the Content Items you created are missing, either they are not Public or they are not in the 

Education Folder. 
 

If you access the home page in a browser by entering http://localhost:9992/EI_Home/index.html, and then 

click the Education link in the right navigation pane, your Tuition page will resemble the following: 
 

 
 

Figure 47: Published Tuition content item 

http://localhost:9992/EI_Home/index.html
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C H A P T  E R 5 
 
 

 

Troubleshooting 
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Installation 
 

 

Installer Cannot Connect to the Repository 

This indicates improper entry of the Server’s IP, User ID, or Password. 

Solution: 

For SQL Server, follow the next few steps to establish a connection: 
 

 Confirm the existence of the sa account through Microsoft’s Enterprise Manager Utility. 

 Confirm, and if necessary, change, the sa password. 

 Re-attempt connection to the Server. If it still fails, confirm the port on which SQL Server is 

listening in Enterprise Manager: 

a)   Select Tools > SQL Server Configuration Properties. 
 

The SQL Server Properties dialog opens to the General tab. 

b)   Press the [Network Configuration] button. 

The SQL Server Network Utility dialog opens to the General tab. 

c)   Highlight the TCP/IP protocol and press the [Properties] button. 

The Network Protocol Default Value Setup dialog opens. 

 
 

Figure 48: Network Protocol Default Value Setup dialog 
 

d)   If the port number listed is not 1433, change it and press [OK]. 

e)   Exit Enterprise Manager and restart SQL Server. 
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Startup 
 

 

Server Shuts Down During Initialization 
 

Server encounters an error and shuts down during initialization 
 

Solution: 
 

Go to <Rhythmyx root>\AppServer\server\rx\log. First open boot.log and look for error messages giving 

you details about the server shut down. If you still need more information, go to server.log and read 

through any error messages. 
 
 

CM System License Period Expired 
 

On startup, the CM System Server displays the message, “The evaluation period for this license 

has expired.” 
 

Solution: 

This error indicates that your license for CM System has expired, and you need a new license. Contact 

Percussion Technical Support for a new license and for instructions about updating your installation. 
 
 

Out-of-Memory Condition Displayed on CM System 
Startup 
The CM System Server console displays an out of memory condition when you attempt to start CM 

System. Solution: 

Change the server configuration to allow for at least 1024 megabytes of RAM. 2048 megabytes is 
recommended. 
 
Edit the RhythmyxServer.bin.lax or RhythmyxServer.lax file.  Edit the line .ax.nl.java.option.additional to 
set the -Xmx 
 
lax.nl.java.option.additional=-Dprogram.name=RhythmyxServer.exe -Xms128m –Xmx1024 
m -Djava.endorsed.dirs="AppServer/lib/endorsed" -Djava.library.path=./bin -serve 
r -XX:MaxPermSize=128m 
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